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Preface

IBM® SPSS® Modeler is the IBM Corp. enterprise-strength data mining workbench. SPSS Modeler helps
organizations to improve customer and citizen relationships through an in-depth understanding of data.
Organizations use the insight gained from SPSS Modeler to retain profitable customers, identify
cross-selling opportunities, attract new customers, detect fraud, reduce risk, and improve government
service delivery.

SPSS Modeler's visual interface invites users to apply their specific business expertise, which leads to
more powerful predictive models and shortens time-to-solution. SPSS Modeler offers many modeling
techniques, such as prediction, classification, segmentation, and association detection algorithms. Once
models are created, IBM SPSS Modeler Solution Publisher enables their delivery enterprise-wide to
decision makers or to a database.

About IBM Business Analytics
IBM Business Analytics software delivers complete, consistent and accurate information that
decision-makers trust to improve business performance. A comprehensive portfolio of business
intelligence, predictive analytics, financial performance and strategy management, and analytic
applications provides clear, immediate and actionable insights into current performance and the ability to
predict future outcomes. Combined with rich industry solutions, proven practices and professional
services, organizations of every size can drive the highest productivity, confidently automate decisions
and deliver better results.

As part of this portfolio, IBM SPSS Predictive Analytics software helps organizations predict future events
and proactively act upon that insight to drive better business outcomes. Commercial, government and
academic customers worldwide rely on IBM SPSS technology as a competitive advantage in attracting,
retaining and growing customers, while reducing fraud and mitigating risk. By incorporating IBM SPSS
software into their daily operations, organizations become predictive enterprises – able to direct and
automate decisions to meet business goals and achieve measurable competitive advantage. For further
information or to reach a representative visit http://www.ibm.com/spss.

Technical Support
Technical support is available to maintenance customers. Customers may contact Technical Support for
assistance in using IBM Corp. products or for installation help for one of the supported hardware
environments. To reach Technical Support, see the IBM Corp. web site at http://www.ibm.com/support.
Be prepared to identify yourself, your organization, and your support agreement when requesting
assistance.

v

http://www-01.ibm.com/software/data/businessintelligence/
http://www-01.ibm.com/software/data/businessintelligence/
http://www-01.ibm.com/software/analytics/spss/
http://www-01.ibm.com/software/data/cognos/financial-performance-management.html
http://www-01.ibm.com/software/data/cognos/products/cognos-analytic-applications/
http://www-01.ibm.com/software/data/cognos/products/cognos-analytic-applications/
http://www.ibm.com/spss
http://www.ibm.com/support
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Chapter 1. About IBM SPSS Modeler

IBM SPSS Modeler is a set of data mining tools that enable you to quickly develop predictive models
using business expertise and deploy them into business operations to improve decision making. Designed
around the industry-standard CRISP-DM model, IBM SPSS Modeler supports the entire data mining
process, from data to better business results.

IBM SPSS Modeler offers a variety of modeling methods taken from machine learning, artificial
intelligence, and statistics. The methods available on the Modeling palette allow you to derive new
information from your data and to develop predictive models. Each method has certain strengths and is
best suited for particular types of problems.

SPSS Modeler can be purchased as a standalone product, or used as a client in combination with SPSS
Modeler Server. A number of additional options are also available, as summarized in the following
sections. For more information, see http://www.ibm.com/software/analytics/spss/products/modeler/.

IBM SPSS Modeler Products
The IBM SPSS Modeler family of products and associated software comprises the following.
v IBM SPSS Modeler
v IBM SPSS Modeler Server
v IBM SPSS Modeler Administration Console (included with IBM SPSS Deployment Manager)
v IBM SPSS Modeler Batch
v IBM SPSS Modeler Solution Publisher
v IBM SPSS Modeler Server adapters for IBM SPSS Collaboration and Deployment Services

IBM SPSS Modeler
SPSS Modeler is a functionally complete version of the product that you install and run on your personal
computer. You can run SPSS Modeler in local mode as a standalone product, or use it in distributed
mode along with IBM SPSS Modeler Server for improved performance on large data sets.

With SPSS Modeler, you can build accurate predictive models quickly and intuitively, without
programming. Using the unique visual interface, you can easily visualize the data mining process. With
the support of the advanced analytics embedded in the product, you can discover previously hidden
patterns and trends in your data. You can model outcomes and understand the factors that influence
them, enabling you to take advantage of business opportunities and mitigate risks.

SPSS Modeler is available in two editions: SPSS Modeler Professional and SPSS Modeler Premium. See
the topic “IBM SPSS Modeler Editions” on page 2 for more information.

IBM SPSS Modeler Server
SPSS Modeler uses a client/server architecture to distribute requests for resource-intensive operations to
powerful server software, resulting in faster performance on larger data sets.

SPSS Modeler Server is a separately-licensed product that runs continually in distributed analysis mode
on a server host in conjunction with one or more IBM SPSS Modeler installations. In this way, SPSS
Modeler Server provides superior performance on large data sets because memory-intensive operations
can be done on the server without downloading data to the client computer. IBM SPSS Modeler Server
also provides support for SQL optimization and in-database modeling capabilities, delivering further
benefits in performance and automation.

© Copyright IBM Corporation 1994, 2016 1
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IBM SPSS Modeler Administration Console
The Modeler Administration Console is a graphical user interface for managing many of the SPSS
Modeler Server configuration options, which are also configurable by means of an options file. The
console is included in IBM SPSS Deployment Manager, can be used to monitor and configure your SPSS
Modeler Server installations, and is available free-of-charge to current SPSS Modeler Server customers.
The application can be installed only on Windows computers; however, it can administer a server
installed on any supported platform.

IBM SPSS Modeler Batch
While data mining is usually an interactive process, it is also possible to run SPSS Modeler from a
command line, without the need for the graphical user interface. For example, you might have
long-running or repetitive tasks that you want to perform with no user intervention. SPSS Modeler Batch
is a special version of the product that provides support for the complete analytical capabilities of SPSS
Modeler without access to the regular user interface. SPSS Modeler Server is required to use SPSS
Modeler Batch.

IBM SPSS Modeler Solution Publisher
SPSS Modeler Solution Publisher is a tool that enables you to create a packaged version of an SPSS
Modeler stream that can be run by an external runtime engine or embedded in an external application. In
this way, you can publish and deploy complete SPSS Modeler streams for use in environments that do
not have SPSS Modeler installed. SPSS Modeler Solution Publisher is distributed as part of the IBM SPSS
Collaboration and Deployment Services - Scoring service, for which a separate license is required. With
this license, you receive SPSS Modeler Solution Publisher Runtime, which enables you to execute the
published streams.

For more information about SPSS Modeler Solution Publisher, see the IBM SPSS Collaboration and
Deployment Services documentation. The IBM SPSS Collaboration and Deployment Services Knowledge
Center contains sections called "IBM SPSS Modeler Solution Publisher" and "IBM SPSS Analytics Toolkit."

IBM SPSS Modeler Server Adapters for IBM SPSS Collaboration and
Deployment Services
A number of adapters for IBM SPSS Collaboration and Deployment Services are available that enable
SPSS Modeler and SPSS Modeler Server to interact with an IBM SPSS Collaboration and Deployment
Services repository. In this way, an SPSS Modeler stream deployed to the repository can be shared by
multiple users, or accessed from the thin-client application IBM SPSS Modeler Advantage. You install the
adapter on the system that hosts the repository.

IBM SPSS Modeler Editions
SPSS Modeler is available in the following editions.

SPSS Modeler Professional

SPSS Modeler Professional provides all the tools you need to work with most types of structured data,
such as behaviors and interactions tracked in CRM systems, demographics, purchasing behavior and
sales data.

SPSS Modeler Premium

SPSS Modeler Premium is a separately-licensed product that extends SPSS Modeler Professional to work
with specialized data such as that used for entity analytics or social networking, and with unstructured
text data. SPSS Modeler Premium comprises the following components.
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IBM SPSS Modeler Entity Analytics adds an extra dimension to IBM SPSS Modeler predictive analytics.
Whereas predictive analytics attempts to predict future behavior from past data, entity analytics focuses
on improving the coherence and consistency of current data by resolving identity conflicts within the
records themselves. An identity can be that of an individual, an organization, an object, or any other
entity for which ambiguity might exist. Identity resolution can be vital in a number of fields, including
customer relationship management, fraud detection, anti-money laundering, and national and
international security.

IBM SPSS Modeler Social Network Analysis transforms information about relationships into fields that
characterize the social behavior of individuals and groups. Using data describing the relationships
underlying social networks, IBM SPSS Modeler Social Network Analysis identifies social leaders who
influence the behavior of others in the network. In addition, you can determine which people are most
affected by other network participants. By combining these results with other measures, you can create
comprehensive profiles of individuals on which to base your predictive models. Models that include this
social information will perform better than models that do not.

IBM SPSS Modeler Text Analytics uses advanced linguistic technologies and Natural Language
Processing (NLP) to rapidly process a large variety of unstructured text data, extract and organize the key
concepts, and group these concepts into categories. Extracted concepts and categories can be combined
with existing structured data, such as demographics, and applied to modeling using the full suite of IBM
SPSS Modeler data mining tools to yield better and more focused decisions.

IBM SPSS Modeler Documentation
Documentation in online help format is available from the Help menu of SPSS Modeler. This includes
documentation for SPSS Modeler, SPSS Modeler Server, as well as the Applications Guide (also referred
to as the Tutorial), and other supporting materials.

Complete documentation for each product (including installation instructions) is available in PDF format,
in a separate compressed folder, as part of the product download. The PDF documents can also be
downloaded from the web at http://www.ibm.com/support/docview.wss?uid=swg27046871.

Documentation in both formats is also available from the SPSS Modeler Knowledge Center at
http://www-01.ibm.com/support/knowledgecenter/SS3RA7_18.1.0.

SPSS Modeler Professional Documentation
The SPSS Modeler Professional documentation suite (excluding installation instructions) is as follows.
v IBM SPSS Modeler User's Guide. General introduction to using SPSS Modeler, including how to build

data streams, handle missing values, build CLEM expressions, work with projects and reports, and
package streams for deployment to IBM SPSS Collaboration and Deployment Services or IBM SPSS
Modeler Advantage.

v IBM SPSS Modeler Source, Process, and Output Nodes. Descriptions of all the nodes used to read,
process, and output data in different formats. Effectively this means all nodes other than modeling
nodes.

v IBM SPSS Modeler Modeling Nodes. Descriptions of all the nodes used to create data mining
models. IBM SPSS Modeler offers a variety of modeling methods taken from machine learning,
artificial intelligence, and statistics.

v IBM SPSS Modeler Algorithms Guide. Descriptions of the mathematical foundations of the modeling
methods used in IBM SPSS Modeler. This guide is available in PDF format only.

v IBM SPSS Modeler Applications Guide. The examples in this guide provide brief, targeted
introductions to specific modeling methods and techniques. An online version of this guide is also
available from the Help menu. See the topic “Application Examples” on page 4 for more information.

v IBM SPSS Modeler Python Scripting and Automation. Information on automating the system
through Python scripting, including the properties that can be used to manipulate nodes and streams.
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v IBM SPSS Modeler Deployment Guide. Information on running IBM SPSS Modeler streams as steps
in processing jobs under IBM SPSS Deployment Manager.

v IBM SPSS Modeler CLEF Developer's Guide. CLEF provides the ability to integrate third-party
programs such as data processing routines or modeling algorithms as nodes in IBM SPSS Modeler.

v IBM SPSS Modeler In-Database Mining Guide. Information on how to use the power of your
database to improve performance and extend the range of analytical capabilities through third-party
algorithms.

v IBM SPSS Modeler Server Administration and Performance Guide. Information on how to configure
and administer IBM SPSS Modeler Server.

v IBM SPSS Deployment Manager User Guide. Information on using the administration console user
interface included in the Deployment Manager application for monitoring and configuring IBM SPSS
Modeler Server.

v IBM SPSS Modeler CRISP-DM Guide. Step-by-step guide to using the CRISP-DM methodology for
data mining with SPSS Modeler.

v IBM SPSS Modeler Batch User's Guide. Complete guide to using IBM SPSS Modeler in batch mode,
including details of batch mode execution and command-line arguments. This guide is available in
PDF format only.

SPSS Modeler Premium Documentation
The SPSS Modeler Premium documentation suite (excluding installation instructions) is as follows.
v IBM SPSS Modeler Entity Analytics User Guide. Information on using entity analytics with SPSS

Modeler, covering repository installation and configuration, entity analytics nodes, and administrative
tasks.

v IBM SPSS Modeler Social Network Analysis User Guide. A guide to performing social network
analysis with SPSS Modeler, including group analysis and diffusion analysis.

v SPSS Modeler Text Analytics User's Guide. Information on using text analytics with SPSS Modeler,
covering the text mining nodes, interactive workbench, templates, and other resources.

Application Examples
While the data mining tools in SPSS Modeler can help solve a wide variety of business and
organizational problems, the application examples provide brief, targeted introductions to specific
modeling methods and techniques. The data sets used here are much smaller than the enormous data
stores managed by some data miners, but the concepts and methods that are involved are scalable to
real-world applications.

To access the examples, click Application Examples on the Help menu in SPSS Modeler.

The data files and sample streams are installed in the Demos folder under the product installation
directory. For more information, see “Demos Folder.”

Database modeling examples. See the examples in the IBM SPSS Modeler In-Database Mining Guide.

Scripting examples. See the examples in the IBM SPSS Modeler Scripting and Automation Guide.

Demos Folder
The data files and sample streams that are used with the application examples are installed in the Demos
folder under the product installation directory (for example: C:\Program Files\IBM\SPSS\Modeler\
<version>\Demos). This folder can also be accessed from the IBM SPSS Modeler program group on the
Windows Start menu, or by clicking Demos on the list of recent directories in the File > Open Stream
dialog box.
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License tracking
When you use SPSS Modeler, license usage is tracked and logged at regular intervals. The license metrics
that are logged are AUTHORIZED_USER and CONCURRENT_USER, and the type of metric that is
logged depends on the type of license that you have for SPSS Modeler.

The log files that are produced can be processed by the IBM License Metric Tool, from which you can
generate license usage reports.

The license log files are created in the same directory where SPSS Modeler Client log files are recorded
(by default, %ALLUSERSPROFILE%/IBM/SPSS/Modeler/<version>/log).

Chapter 1. About IBM SPSS Modeler 5
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Chapter 2. Batch Mode Execution

Introduction to Batch Mode
Data mining is usually an interactive process—you interact with data and models to improve your
understanding of the data and the domain it represents. However, IBM SPSS Modeler streams can also be
used to process data and perform data mining tasks in batch mode, with no visible user interface. Batch
mode allows long-running or repetitive tasks to be performed without your intervention and without the
presence of the user interface on the screen.

For customers who want to run IBM SPSS Modeler exclusively in batch mode, IBM SPSS Modeler Batch
is a special version of the product that provides support for the complete analytical capabilities of IBM
SPSS Modeler without access to the regular user interface. An IBM SPSS Modeler Server license is
required to use batch mode.

Examples of tasks appropriate for batch mode include:
v Running a time-consuming modeling exercise in the background.
v Running a stream at a scheduled time (for example, overnight, when the resultant load on the

computer will not be inconvenient).
v Running a data preprocessing stream on a large volume of data (for example, in the background

and/or overnight).
v Running regularly scheduled tasks, such as monthly reports.
v Running a stream as an embedded part of another process, such as a scoring engine facility.

Note: IBM SPSS Modeler operations can be scheduled in batch mode using the appropriate operating
system commands or utilities (for example, the at command under Windows NT).

Working in Batch Mode
Working in batch mode typically involves:
1. Invoking IBM SPSS Modeler in batch mode using the clemb command.
2. Connecting to a server.
3. Loading an existing stream or script file.
4. Executing the stream or script.

Note: SPSS Modeler Batch requires 4GB of available memory.

Once execution is complete, you can then consult the log file produced by default in batch mode and
view the results of graphs, output nodes, and models. For more information about these steps, see the
following topics.

Invoking the Software
You can use the command line of your operating system to launch IBM SPSS Modeler as follows:
1. On a computer where IBM SPSS Modeler is installed, open a DOS, or command-prompt, window.
2. To launch the IBM SPSS Modeler interface in interactive mode, type the modelerclient command

followed by the required arguments; for example:
modelerclient -stream report.str -execute

© Copyright IBM Corporation 1994, 2016 7



The available arguments (flags) allow you to connect to a server, load streams, run scripts, or specify
other parameters as needed.

Using Command Line Arguments
In order for IBM SPSS Modeler to open and execute files (such as streams and scripts) in batch mode,
you need to alter the initial command (clemb) that launches the software. There are a number of
command line arguments, also referred to as flags, that you can use to:
v Connect to a server.
v Load streams, scripts, models, states, projects, and output files. (If you have licensed IBM SPSS

Collaboration and Deployment Services Repository, you can connect to a repository and load objects
from it.)

v Specify log file options.
v Set default directories for use in IBM SPSS Modeler.

All of the above operations require the use of flags appended to the clemb command. Flags follow the
form -flag, where the hyphen precedes the argument itself. For example, using the flag -server in
conjunction with the initial argument clemb will connect to the server specified using other flag options.

You can combine the clemb command with a number of other startup flags, such as -server, -stream, and
-execute, in order to load and execute streams in batch mode. The following command loads and
executes the stream report.str without invoking the user interface:
clemb -server -hostname myserver -port 80
-username dminer -password 1234 -stream report.str -execute

For a complete list of command line arguments, see Chapter 3, “Command Line Arguments,” on page 11.
v IBM SPSS Modeler states and scripts are also executed in this manner, using the -state and -script

flags, respectively. Multiple states and streams can be loaded by specifying the relevant flag for each
item.

v Multiple arguments can be combined into a single command file and specified at startup using the @
symbol. See the topic “Combining Multiple Arguments” on page 15 for more information.

Batch Mode Log Files
Running in batch mode produces a log file. By default, the name of this log file is clem_batch.log, but you
can specify an alternative name using the -log flag. For example, the following command executes
report.str in batch mode and sends the logging information to report.log:
clemb -server -hostname myserver -port 80
-username dminer -password 1234 -stream report.str
-execute -log report.log

Normally, the log file overwrites any existing file of the same name, but you can make IBM SPSS
Modeler append to the log file instead by using the -appendlog flag. Logging can also be suppressed
altogether by using the -nolog flag.

Note: Logging arguments are available only when running in batch mode.

Scripting in Batch Mode
In its simplest form, batch mode execution of IBM SPSS Modeler streams is performed one at a time
using the command line arguments discussed in this guide. A given stream is executed without
significantly altering its node parameters. While this may work well for automated production of
monthly churn reports or predictions, it cannot handle the sophisticated processes that many advanced
data miners would like to automate.
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For example, a financial institution may want to construct a number of models using different data or
modeling parameters, test the models on another set of data, and produce a report on the results. Because
this process requires repetitive modifications to a stream and the creation and deletion of nodes,
automating it requires the use of scripting. Scripting allows complex processes that would otherwise
require user intervention to be automated and executed in batch mode.

To Execute a Script in Batch Mode

1. Append the clemb command with the -script flag, specifying the name of the script that you want to
execute.

2. Also use the -execute flag with the above arguments to execute the specified script. This will run the
stand-alone script in its entirety.

For example, to load and execute a script that runs a model producing churn scores that are stored as
output for the data warehouse, you would use the following command:
clemb -server -hostname myserver -port 80
-username dminer -password 1234
-script clemscript.txt -execute

Using Parameters in Batch Mode
You can modify the effect of executing a stream in batch mode by supplying parameters to the command
line launch of IBM SPSS Modeler. These might be simple parameters used directly in CLEM expressions,
or they might be node properties, also called slot parameters, which are used to modify the settings of
nodes in the stream.

For example, the following stream selects a subset of data from a file, passes it through a neural net, and
sends the results to a file:

The value of the field Month determines the selected data; the expression in the Select node is:
Month == ’$P-mth’

When running the same stream in batch mode, select the appropriate month by setting the value of the
parameter mth in the command line:
clemb -server -hostname myserver -port 80
-username dminer -password 1234
-stream predict.str -Pmth=Jan -execute

Note: In command line arguments, the -P flag is used to denote a parameter.

Sometimes the required command line control of the stream involves modifying the settings of the nodes
in the stream using slot parameters. Consider the following stream, which reads a file, processes its
contents, and sends a report to another file:

Figure 1. Stream operations in the user interface
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Suppose that you want to generate the report once a month, reading the appropriate month's data and
sending the report to a file whose name indicates the relevant month. You might want to set the
filenames for the source data and for the report. The following command sets the appropriate slot
parameters and executes the stream:
clemb -stream report.str -Porder.full_filename=APR_orders.dat
-Preport.filename=APR_report.txt -execute

Note: This command does not contain the operating-system-specific code that schedules it to run monthly.

Working with Output in Batch Mode
Working with visual output, such as tables, graphs, and charts, typically requires a user interface. Since
batch mode does not launch the IBM SPSS Modeler user interface, output objects are diverted to a file so
that you can view them later, either in the user interface or in another software package. Using the
properties available for nodes (slot parameters), you can control the formats and filenames of output
objects created during batch mode.

Figure 2. Stream operations in the user interface
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Chapter 3. Command Line Arguments

Invoking the Software
You can use the command line of your operating system to launch IBM SPSS Modeler as follows:
1. On a computer where IBM SPSS Modeler is installed, open a DOS, or command-prompt, window.
2. To launch the IBM SPSS Modeler interface in interactive mode, type the modelerclient command

followed by the required arguments; for example:
modelerclient -stream report.str -execute

The available arguments (flags) allow you to connect to a server, load streams, run scripts, or specify
other parameters as needed.

Using Command Line Arguments
You can append command line arguments (also referred to as flags) to the initial modelerclient command
to alter the invocation of IBM SPSS Modeler.

Several types of command line arguments are available, and are described later in this section.

Table 1. Types of command line arguments.

Argument type Where described

System arguments See the topic “System Arguments” on page 12 for more
information.

Parameter arguments See the topic “Parameter Arguments” on page 13 for
more information.

Server connection arguments See the topic “Server Connection Arguments” on page 13
for more information.

IBM SPSS Collaboration and Deployment Services
Repository connection arguments

See the topic “IBM SPSS Collaboration and Deployment
Services Repository Connection Arguments” on page 14
for more information.

IBM SPSS Analytic Server connection arguments See the topic “IBM SPSS Analytic Server Connection
Arguments” on page 15 for more information.

For example, you can use the -server, -stream and -execute flags to connect to a server and then load
and run a stream, as follows:
modelerclient -server -hostname myserver -port 80 -username dminer
-password 1234 -stream mystream.str -execute

Note that when running against a local client installation, the server connection arguments are not
required.

Parameter values that contain spaces can be enclosed in double quotes—for example:
modelerclient -stream mystream.str -Pusername="Joe User" -execute

You can also execute IBM SPSS Modeler states and scripts in this manner, using the -state and -script
flags, respectively.

Note: If you use a structured parameter in a command, you must precede quotation marks with a
backslash. This prevents the quotation marks being removed during interpretation of the string.

© Copyright IBM Corporation 1994, 2016 11



Debugging Command Line Arguments

To debug a command line, use the modelerclient command to launch IBM SPSS Modeler with the
desired arguments. This enables you to verify that commands will execute as expected. You can also
confirm the values of any parameters passed from the command line in the Session Parameters dialog
box (Tools menu, Set Session Parameters).

System Arguments
The following table describes system arguments available for command line invocation of the user
interface.

Table 2. System arguments

Argument Behavior/Description

@ <commandFile> The @ character followed by a filename specifies a command list. When
modelerclient encounters an argument beginning with @, it operates on the
commands in that file as if they had been on the command line. See the topic
“Combining Multiple Arguments” on page 15 for more information.

-directory <dir> Sets the default working directory. In local mode, this directory is used for both data
and output. Example: -directory c:/ or -directory c:\\

-server_directory <dir> Sets the default server directory for data. The working directory, specified by using
the -directory flag, is used for output.

-execute After starting, execute any stream, state, or script loaded at startup. If a script is
loaded in addition to a stream or state, the script alone will be executed.

-stream <stream> At startup, load the stream specified. Multiple streams can be specified, but the last
stream specified will be set as the current stream.

-script <script> At startup, load the standalone script specified. This can be specified in addition to a
stream or state as described below, but only one script can be loaded at startup.

-model <model> At startup, load the generated model (.gm format file) specified.

-state <state> At startup, load the saved state specified.

-project <project> Load the specified project. Only one project can be loaded at startup.

-output <output> At startup, load the saved output object (.cou format file).

-help Display a list of command line arguments. When this option is specified, all other
arguments are ignored and the Help screen is displayed.

-P <name>=<value> Used to set a startup parameter. Can also be used to set node properties (slot
parameters).

Note: Default directories can also be set in the user interface. To access the options, from the File menu,
choose Set Working Directory or Set Server Directory.

Loading Multiple Files

From the command line, you can load multiple streams, states, and outputs at startup by repeating the
relevant argument for each object loaded. For example, to load and run two streams called report.str and
train.str, you would use the following command:
modelerclient -stream report.str -stream train.str -execute

Loading Objects from the IBM SPSS Collaboration and Deployment Services Repository

Because you can load certain objects from a file or from the IBM SPSS Collaboration and Deployment
Services Repository (if licensed), the filename prefix spsscr: and, optionally, file: (for objects on disk)
tells IBM SPSS Modeler where to look for the object. The prefix works with the following flags:
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v -stream

v -script

v -output

v -model

v -project

You use the prefix to create a URI that specifies the location of the object—for example, -stream
"spsscr:///folder_1/scoring_stream.str". The presence of the spsscr: prefix requires that a valid
connection to the IBM SPSS Collaboration and Deployment Services Repository has been specified in the
same command. So, for example, the full command would look like this:
modelerclient -spsscr_hostname myhost -spsscr_port 8080
-spsscr_username myusername -spsscr_password mypassword
-stream "spsscr:///folder_1/scoring_stream.str" -execute

Note that from the command line, you must use a URI. The simpler REPOSITORY_PATH is not supported. (It
works only within scripts.)

Parameter Arguments
Parameters can be used as flags during command line execution of IBM SPSS Modeler. In command line
arguments, the -P flag is used to denote a parameter of the form -P <name>=<value>.

Parameters can be any of the following:
v Simple parameters (or parameters used directly in CLEM expressions).
v Slot parameters, also referred to as node properties. These parameters are used to modify the settings

of nodes in the stream.
v Command line parameters, used to alter the invocation of IBM SPSS Modeler.

For example, you can supply data source user names and passwords as a command line flag, as follows:
modelerclient -stream response.str -P:databasenode.datasource="{\"ORA 10gR2\", user1, mypsw,
true}"

The format is the same as that of the datasource parameter of the databasenode node property.

Note: If the node is named, you must surround the node name with double quotes and escape the
quotes with a backslash. For example, if the data source node in the preceding example has the name
Source_ABC the entry would be as follows:
modelerclient -stream response.str -P:databasenode.\"Source_ABC\".datasource="{\"ORA 10gR2\",
user1, mypsw, true}"

A backslash is also required in front of the quotes that identify a structured parameter, as in the following
TM1 datasource example:
clemb -server -hostname 9.115.21.169 -port 28053 -username administrator

-execute -stream C:\Share\TM1_Script.str -P:tm1import.pm_host="http://9.115.21.163:9510/pmhub/pm"
-P:tm1import.tm1_connection={\"SData\",\"\",\"admin\",\"apple\"}
-P:tm1import.selected_view={\"SalesPriorCube\",\"salesmargin%\"}

Server Connection Arguments
The -server flag tells IBM SPSS Modeler that it should connect to a public server, and the flags
-hostname, -use_ssl, -port, -username, -password, and -domain are used to tell IBM SPSS Modeler how to
connect to the public server. If no -server argument is specified, the default server is used.

Examples
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To connect to a public server:
modelerclient -server -hostname myserver -port 80 -username dminer
-password 1234 -stream mystream.str -execute

To connect to a server cluster:
modelerclient -server -cluster "QA Machines" \
-spsscr_hostname pes_host -spsscr_port 8080 \
-spsscr_username asmith -spsscr_epassword xyz

Note that connecting to a server cluster requires the Coordinator of Processes through IBM SPSS
Collaboration and Deployment Services, so the -cluster argument must be used in combination with the
repository connection options (spsscr_*). See the topic “IBM SPSS Collaboration and Deployment
Services Repository Connection Arguments” for more information.

Table 3. Server connection arguments.

Argument Behavior/Description

-server Runs IBM SPSS Modeler in server mode, connecting to a public server using the
flags -hostname, -port, -username, -password, and -domain.

-hostname <name> The hostname of the server machine. Available in server mode only.

-use_ssl Specifies that the connection should use SSL (secure socket layer). This flag is
optional; the default setting is not to use SSL.

-port <number> The port number of the specified server. Available in server mode only.

-cluster <name> Specifies a connection to a server cluster rather than a named server; this argument
is an alternative to the hostname, port and use_ssl arguments. The name is the
cluster name, or a unique URI which identifies the cluster in the IBM SPSS
Collaboration and Deployment Services Repository. The server cluster is managed
by the Coordinator of Processes through IBM SPSS Collaboration and Deployment
Services. See the topic “IBM SPSS Collaboration and Deployment Services
Repository Connection Arguments” for more information.

-username <name> The user name with which to log on to the server. Available in server mode only.

-password <password> The password with which to log on to the server. Available in server mode only.
Note: If the -password argument is not used, you will be prompted for a password.

-epassword
<encodedpasswordstring>

The encoded password with which to log on to the server. Available in server
mode only. Note: An encoded password can be generated from the Tools menu of
the IBM SPSS Modeler application.

-domain <name> The domain used to log on to the server. Available in server mode only.

-P <name>=<value> Used to set a startup parameter. Can also be used to set node properties (slot
parameters).

IBM SPSS Collaboration and Deployment Services Repository
Connection Arguments
If you want to store or retrieve objects from IBM SPSS Collaboration and Deployment Services via the
command line, you must specify a valid connection to the IBM SPSS Collaboration and Deployment
Services Repository. For example:
modelerclient -spsscr_hostname myhost -spsscr_port 8080
-spsscr_username myusername -spsscr_password mypassword
-stream "spsscr:///folder_1/scoring_stream.str" -execute

The following table lists the arguments that can be used to set up the connection.
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Table 4. IBM SPSS Collaboration and Deployment Services Repository connection arguments

Argument Behavior/Description

-spsscr_hostname <hostname or IP
address>

The hostname or IP address of the server on which the IBM SPSS
Collaboration and Deployment Services Repository is installed.

-spsscr_port <number> The port number on which the IBM SPSS Collaboration and Deployment
Services Repository accepts connections (typically, 8080 by default).

-spsscr_use_ssl Specifies that the connection should use SSL (secure socket layer). This
flag is optional; the default setting is not to use SSL.

-spsscr_username <name> The user name with which to log on to the IBM SPSS Collaboration and
Deployment Services Repository.

-spsscr_password <password> The password with which to log on to the IBM SPSS Collaboration and
Deployment Services Repository.

-spsscr_epassword <encoded password> The encoded password with which to log on to the IBM SPSS
Collaboration and Deployment Services Repository.

-spsscr_domain <name> The domain used to log on to the IBM SPSS Collaboration and
Deployment Services Repository. This flag is optional—do not use it
unless you log on by using LDAP or Active Directory.

IBM SPSS Analytic Server Connection Arguments
If you want to store or retrieve objects from IBM SPSS Analytic Server via the command line, you must
specify a valid connection to IBM SPSS Analytic Server.

Note: The location of Analytic Server is obtained from SPSS Modeler Server and cannot be changed on
the client.

The following table lists the arguments that can be used to set up the connection.

Table 5. IBM SPSS Analytic Server connection arguments

Argument Behavior/Description

-analytic_server_username The user name with which to log on to IBM SPSS Analytic Server.

-analytic_server_password The password with which to log on to IBM SPSS Analytic Server.

-analytic_server_epassword The encoded password with which to log on to IBM SPSS Analytic
Server.

-analytic_server_credential The credentials used to log on to IBM SPSS Analytic Server.

Combining Multiple Arguments
Multiple arguments can be combined in a single command file specified at invocation by using the @
symbol followed by the filename. This enables you to shorten the command line invocation and
overcome any operating system limitations on command length. For example, the following startup
command uses the arguments specified in the file referenced by <commandFileName>.
modelerclient @<commandFileName>

Enclose the filename and path to the command file in quotation marks if spaces are required, as follows:
modelerclient @ "C:\Program Files\IBM\SPSS\Modeler\nn\scripts\my_command_file.txt"

The command file can contain all arguments previously specified individually at startup, with one
argument per line. For example:
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-stream report.str
-Porder.full_filename=APR_orders.dat
-Preport.filename=APR_report.txt
-execute

When writing and referencing command files, be sure to follow these constraints:
v Use only one command per line.
v Do not embed an @CommandFile argument within a command file.
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Notices

This information was developed for products and services offered in the US. This material might be
available from IBM in other languages. However, you may be required to own a copy of the product or
product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

The performance data and client examples cited are presented for illustrative purposes only. Actual
performance results may vary depending on specific configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to
non-IBMproducts. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.
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Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all
proprietary notices are preserved. You may not distribute, display or make derivative work of these
publications, or any portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that
all proprietary notices are preserved. You may not make derivative works of these publications, or
reproduce, distribute or display these publications or any portion thereof outside your enterprise, without
the express consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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